1 CONTENTS

1 Contents .................................................................................................................................................................... 2

2 Overview .................................................................................................................................................................... 3

3 Sequential features ................................................................................................................................................ 4

  3.1 Contrast Optimization (Professional and Premium) .................................................................. 4

  3.2 Up to 50 field points (Professional and Premium) .............................................................. 5

  3.3 Over 200 field points (Premium) ......................................................................................... 6

  3.4 New Field Data Editor (All editions) .............................................................................. 7

  3.5 Fields Wizard (All editions) ......................................................................................... 7

  3.6 Field Conversion tool (All editions) ............................................................................... 8

  3.7 Min/max MTF operands (All editions) ........................................................................ 9

  3.8 Updated CODE V® file converter (All editions) ......................................................... 10

4 Non-sequential features ................................................................................................................................... 11

  4.1 Enhanced photoluminescence (Premium) .............................................................................. 11

  4.2 Optomechanical apertures for Odd Asphere Lenses (Professional and Premium) ............. 12

  4.3 Updated CAD dynamic links (Premium) ........................................................................ 13

  4.4 Operand to create ZRD files (Professional and Premium) ...................................................... 13

5 Programming ........................................................................................................................................................ 14

  5.1 API examples & interface documentation (Professional and Premium) .............................. 14

6 New Online Edition ............................................................................................................................................ 16

  6.1 OpticStudio Online (New Online Edition) .............................................................................. 16

  6.2 OpticStudio Online: US East Coast and Ireland (New Online Edition) ............................. 17

7 Usability .................................................................................................................................................................. 18

  7.1 Ignore tolerance operands (All editions) ........................................................................... 18

  7.2 Updated Zemax License Manager (All editions) .................................................................... 18

  7.3 Autosave (All editions) ........................................................................................................ 19

  7.4 Custom Zemax data folder location (All editions) ........................................................... 20

8 Performance .......................................................................................................................................................... 21

  8.1 Improved performance for Spot X+Y Optimization (All editions) ......................................... 21

  8.2 Editor Speed Improvements (All editions) ........................................................................... 22

9 Documentation .................................................................................................................................................... 23
2 OVERVIEW

OpticStudio 17 includes unprecedented new features for optical system design.

The OpticStudio® 17 release takes optical design to the next level. Optimize for MTF at least 30x faster than before, trace more rays than any other optical design software, build custom applications with the new API documentation, and simulate phosphors and fluorescence with the most accurate model available.

The available editions of OpticStudio are Standard, Professional, and Premium. Each new feature is labeled with the edition(s) in which it is available. Please see our website for more information about the different editions of OpticStudio, or contact your local sales team to upgrade.

The Standard Edition includes improvements including a new Field Data Editor, Fields Wizard, and field conversion tool. You can use the improved Spot X+Y default merit function, which is now the fastest way to optimize for small spot sizes. Test different tolerances with a new on/off toggle. Customize the location of your design files. And more!

The Professional Edition includes all features available in the Standard Edition, plus the Contrast Optimizer, which uses the innovative new Moore-Elliot method. You can also use the new API documentation interface, with over 20 examples for MATLAB, C++, C#, and Python.

The Premium Edition includes all features available in the Standard and Professional editions, plus the ability to trace rays from more than 200 field points, so you can design complex freeform systems with high accuracy. You can also design new phosphorescence systems, like a fluorescent solar concentrator, with the most comprehensive ray-based phosphors and fluorescence model on the market. The Premium Edition is available on-premise or as an online subscription called the Online Edition.
3 SEQUENTIAL FEATURES

3.1 CONTRAST OPTIMIZATION (PROFESSIONAL AND PREMIUM)

Robustly optimize optical systems for MTF at least 30x faster with Contrast Optimization.

Zemax has developed a new optimization method called Contrast Optimization, which uses the Moore-Elliott theory to target the best MTF response up to a desired spatial frequency. This ground-breaking MTF optimization method has been added as a new criterion for the Optimization Wizard. Building this merit function populates the Merit Function Editor with MECS, MECT, and MECA operands.

Optimization of the MTF is especially useful for extended images with cutoff frequencies set by the detectors, since lower spatial frequencies can be improved at the expense of higher, unneeded frequencies. Until now, the only way to optimize for the best MTF has been to optimize directly on the MTF value, but this is slow, difficult, and often fails. Contrast Optimization, on the other hand, increases the MTF in a more robust way, which means you can use this optimization method earlier in the design process, even for highly aberrated systems. In addition, it is at least 30x faster than previous MTF optimization methods, which significantly decreases the amount of time spent designing.

Find the new Contrast Optimization in the sequential Optimization Wizard. The Optimization Wizard can be opened from the Optimize tab, or by expanding the Wizards and Operands section of the Merit Function Editor.
3.2 **UP TO 50 FIELD POINTS (PROFESSIONAL AND PREMIUM)**

Efficiently optimize and tolerance non-rotationally symmetric systems with up to 50 field points.

In previous OpticStudio versions, you could analyze, design, and tolerance imaging systems using only 12 field points in sequential mode. You can now use up to 50 field points in the Professional Edition.

With 50 field points, you can analyze 50 light paths in one sequential configuration. All these field points are considered when optimizing and tolerancing, which is extremely useful for designing off-axis or non-rotationally symmetric systems. In addition, capturing all field points in one configuration makes it easy to create additional configurations for varying temperature, pressure, or zoom lens positions. Note that only the first 12 field points are displayed in the system viewer windows and in the analysis plots. Please [let us know](#) if you’d like to see more than 12 fields displayed in the analysis windows.
Find the additional field points in the Field Data Editor. The Field Data Editor can be opened from the Fields section of the System Explorer, or in the Setup tab > Editors group.

3.3 OVER 200 FIELD POINTS (PREMIUM)

Accurately simulate and design highly complex freeform systems with more than 200 field points.

In previous OpticStudio versions, you could use only 12 field points in sequential mode. You can now use more than 200 field points in the Premium Edition.

With more than 200 field points, you can accurately simulate, analyze, and tolerance highly complex freeform systems. This is because freeform surfaces require extremely high sampling densities to simulate the detailed changes in wavefront and aberrations across the field. Now, more than 200 field points can be stored in the same configuration, making it easy to create additional configurations for changes in temperature, pressure, or lens positions. Note that only the first 12 field points are displayed in the system viewer windows and in the analysis plots. Please let us know if you’d like to see more than 12 fields displayed in the analysis windows.
Find the additional field points in the Field Data Editor. The Field Data Editor can be opened from the Fields section of the System Explorer, or in the Setup tab > Editors group.

### 3.4 NEW FIELD DATA EDITOR (ALL EDITIONS)

Easily edit and manage your sequential field points with the new Field Data Editor.

The Field Data Editor has been updated to include the same functionality that is in the Merit Function Editor, Lens Data Editor, and other OpticStudio editors.

It’s now easier to navigate, manage, and sort large numbers of field points. The added functionality includes comments, pickups, a right-click menu, the ability to copy and paste multiple cells, rearrange, resize, and hide columns, use the insert/delete keys to add/remove fields, and more.

Find the Field Data Editor in the Fields section of the System Explorer, or in the Setup tab > Editors group.

### 3.5 FIELDS WIZARD (ALL EDITIONS)

Automatically generate systematic distributions of field points with the new Fields Wizard.

The Fields Wizard populates the Field Data Editor with field points according to the selected distribution. Available distributions include: uniform y fields, equal-area y fields, uniform x fields, equal-area x fields, grid, uniform radial fields, and equal-area radial fields.
This new wizard eliminates the need for manual, error-prone data entry of field points. The wizard is especially helpful for generating a highly sampled field of view.

Find the new Fields Wizard in the Field Data Editor. The Field Data Editor can be opened from the Fields section of the System Explorer, or in the Setup tab > Editors group.

3.6 **FIELD CONVERSION TOOL (ALL EDITIONS)**

*Quickly switch between different field definitions using the new Field Conversion tool.*

The Field Conversion tool converts field types from one definition to another. For example, you can switch from field points defined by angles to the equivalent fields defined by object height.

This new tool eliminates manual, error-prone conversion between field definitions. It’s now easier to switch between field type definitions during the design process or when comparing design files. For example, it is common to define field points by the image height at the beginning of a design, but this definition isn’t recommended for the final design, when object height or input angle is a better practice.

Find the new Field Conversion tool in the Field Type section of the Field Data Editor. The Field Data Editor can be opened from the Fields section of the System Explorer, or in the Setup tab > Editors group.
3.7 **MIN/MAX MTF OPERANDS (ALL EDITIONS)**

Simplify your merit function and ensure your system is meeting your MTF requirements with the new minimum and maximum MTF operands.

New MTF operands in the Merit Function Editor display either the minimum or maximum of both the sagittal and tangential MTF responses. In previous OpticStudio versions, you could only return the sagittal, tangential, or average, and returning the minimum or maximum required at least three operands.

These new operands simplify merit functions, making it easier to ensure that the MTF meets the required specification across both the sagittal and tangential orientations. For more information about how to
rotate the sagittal and tangential analysis orientations of the pupil, see section 9.1 about Tangential Angle Calculations.

Find the new MTFX and MTFN operands in the sequential Merit Function Editor. The Merit Function Editor can be opened from the Optimize tab.

3.8 UPDATED CODE V® FILE CONVERTER (ALL EDITIONS)

Quickly convert *.SEQ files into sequential OpticStudio files.

The CODE V file converter has been improved to better handle conversion of multiple field points, field weights, private glass catalogs, mirror substrate settings, Q-type asphere surface properties, Q-type asphere coefficients, rectangular apertures, multiple configurations with different wavelength weights and field weights, multiple configurations with different y field angles, multiple configurations with different materials, and global coordinate systems.
In one quick step, you can convert your sequential CODE V files into OpticStudio files, including non-rotationally symmetric, off-axis, and multi-configuration systems. Please note that there are still some CODE V commands which are not automatically converted. See the OpticStudio Help Files for a list of all the currently supported commands.

CODE V® is a registered trademark of Synopsys®. Find the CODE V file converter in the Convert File Formats drop-down menu in the File tab.

4 NON-SEQUENTIAL FEATURES

4.1 ENHANCED PHOTOLUMINESCENCE (PREMIUM)

Simulate a wide variety of phosphors and fluorophores with a photoluminescence model that is more accurate than any other ray tracing software.

OpticStudio now accounts for complete wavelength dependence when simulating ray-based fluorescence and phosphorescence. The improved model includes reabsorption of fluorescent light, and spatial dependence using a wavelength-dependent mean-free path. Previously, the mean-free path was not scaled by the wavelength of the incident rays. Therefore, a fluorescent scattering event would occur about once every mean-free path, independent of the corresponding absorption coefficient of the ray, which is based on its wavelength.

These improvements make OpticStudio’s ray-based photoluminescence model more accurate than any other ray tracing software. You can now simulate a wide variety of phosphors and fluorophores, and consider the complete spatial and wavelength dependence of broad spectra incident light. For example, you can design a fluorescent concentrator for a solar cell. OpticStudio’s fluorescence model simulates the down-conversion of incident sunlight into wavelengths which are more efficiently converted by a solar cell. The concentrator and solar cell can be optimized with full consideration of scattering, re-emission, and TIR.
Find the Phosphors and Fluorescence settings in the Volume Physics section of the Non-sequential Component Editor. The Non-sequential Component Editor can be opened from the Editors section of the Setup tab in Non-sequential mode.

4.2 **OPTOMECHANICAL APERTURES FOR ODD ASPHERE LENSES (PROFESSIONAL AND PREMIUM)**

Design complex lens components with realistic apertures.

We've expanded the ability to model realistic apertures (which we call optomechanical semi-diameters) to include more complex objects. OpticStudio can now automatically convert odd asphere surfaces that have realistic apertures to non-sequential mode for stray light analysis. The Odd Asphere object now supports the same optomechanical semi-diameters as the sequential Odd Asphere surface.

The realistic diameter settings include three apertures (clear semi-diameter, chip zone, and mechanical semi-diameter) so that you can model a lens component the same way that it's manufactured.

The Odd Asphere surface can be found in the sequential Lens Data Editor, and the Odd Asphere object can be found in the Non-sequential Component Editor.
4.3 **UPDATED CAD DYNAMIC LINKS (PREMIUM)**

Edit and optimize CAD parts from SOLIDWORKS 2017 and Autodesk Inventor 2018 in OpticStudio.

The dynamic CAD links have been updated to work with the latest version of SOLIDWORKS (2017) and Autodesk Inventor (2018).

You can dynamically open and optimize native SOLIDWORKS, PTC Creo Parametric, and Autodesk Inventor CAD parts in OpticStudio, using the latest version of the CAD software packages.

Find the CAD Part: Autodesk Inventor and CAD Part: SolidWorks in the Non-sequential Component Editor.

4.4 **OPERAND TO CREATE ZRD FILES (PROFESSIONAL AND PREMIUM)**

Automatically save ray database files after optimization with a new non-sequential merit function operand.

You can now create non-sequential ray database files (*.zrd) using operands in the Merit Function Editor.
This means you can save all the ray trace information that was used to optimize your non-sequential system for further analysis after the optimization is completed. This saves time and prevents users from needing to run another ray trace after optimization.

Find the new NSRD operand in the non-sequential Merit Function Editor. The Merit Function Editor can be opened from the Optimize tab.

5 PROGRAMMING

5.1 API EXAMPLES & INTERFACE DOCUMENTATION (PROFESSIONAL AND PREMIUM)

Quickly learn how to use OpticStudio’s API with comprehensive documentation and new examples for MATLAB®, C#, C++, and Python®.

The ZOS-API interface documentation and introductory tutorials are now consolidated in one location. There are code snippets for the most commonly used functions, tools, and analyses, all of which are included in a crosslinked help interface. We also improved search capabilities and inheritance trees across four languages: MATLAB, C#, C++, and Python, and added 80 new examples across these languages.
The consolidated API help and documentation make it easier to get started with the API and switch from the now deprecated DDE language. The examples and code snippets show you how to use the most common functions.

Find the ZOS-API Introduction and Syntax Help through the ZOS-API Help dropdown menu in the Programming tab.
6 NEW ONLINE EDITION

6.1 OPTICSTUDIO ONLINE (NEW ONLINE EDITION)

Access OpticStudio and all your design files from any device with a browser using the new OpticStudio Online Edition.

The new OpticStudio Online Edition allows users to access all the OpticStudio Premium features from a browser anywhere. Zemax provides dedicated servers to host OpticStudio Premium, and it is delivered to your browser as an optimized video stream. This is called the Online Edition, and it is licensed as an annual subscription, which includes access to the latest major release, software updates, and technical support.

OpticStudio Online has no hardware requirements. You don’t need to worry about software updates, installations, or licensing. Just log into your account to run OpticStudio and access your design files on your phone, tablet, Mac, PC, iPad, or Chromebook. The photo below shows OpticStudio Online being used from an iPhone.

The OpticStudio Online Edition also has a new collaboration feature that makes it easy for colleagues to work together from different locations. When you click “Share session” and send the URL to a colleague, they can join your session from their browser. You both see the same view of OpticStudio, and you can share control of the software in real time.
Contact your local sales team to upgrade to the OpticStudio Online Edition.

6.2 OpticStudio Online: US East Coast and Ireland (New Online Edition)

New servers on the US East Coast and in Europe.

We're adding more data servers around the world to optimize your OpticStudio Online usage. These new servers will improve responsivity on the US East Coast and in Europe.

Check your performance and see which server is best for you.
7 USABILITY

7.1 IGNORE TOLERANCE OPERANDS (ALL EDITIONS)
Test and save different tolerances using the new “ignore” toggle for operands in the Tolerance Data Editor.

With one click, you can now ignore operands in the Tolerance Data Editor during tolerancing.

Instead of deleting and adding operands back into the Tolerance Data Editor, you can simply select the "Ignore this operand during tolerancing" check box in the Operand Properties dialog box. This makes it much easier to test and save different tolerance settings.

Find the "Ignore this Operand During Tolerancing" setting in the Operand Properties section of the Tolerance Data Editor. The Tolerance Data Editor can be found in the Tolerance tab.

7.2 UPDATED ZEMAX LICENSE MANAGER (ALL EDITIONS)
Ensure your OpticStudio license is secure with the latest updates to the Zemax License Manager.

The Sentinel LDK runtime libraries have been updated to version 7.55. Also, when transferring a license to a different computer, the notification email now includes the serial number and other detailed information.
This version update brings the Zemax License Manager up to date with the latest security technology and makes it easier to transfer licenses.

Find the Zemax License Manager in the Help tab, or run it as a separate program.

7.3 AUTOSAVE (ALL EDITIONS)
Reduce the risk of data loss with the new Autosave feature.
The new Autosave feature automatically saves changes you’ve made in your OpticStudio file. Both the ZMX and ZDA data files are automatically saved, at user-defined intervals, in the Autosave folder in the Zemax data folder.

Autosave reduces the risk of data loss resulting from a computer crash, freeze, or user error. Now that all your optical system information and calculated analysis data are automatically saved, you don’t need to worry about when you last saved your file, or interrupt your workflow to repeatedly save the file.

Find the Autosave settings in the General section of the Project Preferences. The Project Preferences are in the Setup tab:

7.4 CUSTOM ZEMAX DATA FOLDER LOCATION (ALL EDITIONS)

Customize the location of all your Zemax data files.

You can now redirect the Zemax data folder to any custom location. Previously, this folder was automatically installed in the Documents folder, and the folder path was fixed.
Now, you can save all your Zemax files in the location that is most convenient for you. This is especially helpful if your Documents folder is redirected to a corporate network drive.

Find the customizable Zemax folder location in the Folders section of the Project Preferences. The Project Preferences are in the Setup tab:

8 PERFORMANCE

8.1 IMPROVED PERFORMANCE FOR SPOT X+Y OPTIMIZATION (ALL EDITIONS)

Optimize your optical system for spot size faster using the improved Spot X+Y default merit function.

The algorithm for optimizing the X and Y spot size has been improved. This applies to the default merit function when built using the Spot X+Y criterion in the Merit Function Wizard.
You can create a better design faster using the Spot X+Y criterion in the Merit Function Wizard. The Spot X+Y merit function optimizes significantly faster than all previous versions of OpticStudio and Zemax. The more complicated your optical system, the more time you save. For example, a system with a Chebyshev surface and 90x90 rectangular sampling array optimized more than 30% faster, and was more than 40% faster than optimizing with the RMS spot size merit function.

Find the Spot X+Y merit function criterion in the sequential Optimization Wizard. The Optimization Wizard can be opened from the Optimize tab, or by expanding the Wizards and Operands section of the Merit Function Editor.

### 8.2 Editor Speed Improvements (All Editions)

Quickly navigate and scroll through the OpticStudio editors with the latest responsivity improvements.

Editor performance has been improved for files with many rows in the editors, such as in the Merit Function Editor after using the non-sequential Merit Function Wizard for bitmap optimization. The editors are more responsive when inserting new rows or selecting all rows. Scrolling in the editors is up to 10% faster.
These improvements save you time and improve the usability of all the editors in OpticStudio.

Find the OpticStudio editors in the Setup tab.

9 DOCUMENTATION

9.1 TANGENTIAL ANGLE CALCULATIONS (ALL EDITIONS)
Analyze MTF, wavefront error, aberrations, and more, at any arbitrary orientation in the pupil using the TAN field setting.

The name "Vignetting Angle" (VAN) in the Field Data Editor has been changed to "Tangential Angle" (TAN), because you can use this setting to rotate the orientation of the sagittal and tangential ray fans in a variety of analyses, such as in MTF calculations or the new Contrast Optimization feature. For more information, see section 3.1 about Contrast Optimization.
MTF is the most common metric for orientation-sensitive performance analysis, and often needs to be calculated at a variety of pupil orientations in complex optical systems. For example, in some off-axis or non-rotationally symmetric systems, you may need to check the MTF along both the tangential and sagittal fans, as well as +/- 45 orientations at the same field point.

Find the TAN orientation setting in the Field Data Editor. The Field Data Editor can be opened from the Fields section of the System Explorer, or in the Setup tab > Editors group.

9.2 **UPDATED GETTING STARTED GUIDE (ALL EDITIONS)**

*Quickly get started using OpticStudio with built-in tutorials.*

The tutorials in the Getting Started Using OpticStudio Guide have been updated and expanded. They walk you through an optical design and show you how to use the OpticStudio interface, define sequential surfaces, create a multi-configuration system, export to CAD files, optimize sequential systems, define non-sequential objects, optimize non-sequential systems, and simulate colorimetry, polarization, coatings, and scattering.

Find the Getting Started guide in the Help tab.
9.3 Zemax Lab (All Editions)

Get involved with Zemax feature experiments and research.

The Zemax Lab is a new section of the OpticStudio Help tab. This section is for feature experiments and research surveys where we’re hoping to get your feedback.

9.4 Feature Experiments (All Editions)

See what’s coming and test potential new features.

In the Feature Experiments drop-down menu, you can test out new features that we’re considering implementing in the next OpticStudio release. These features aren’t fully documented, so please let us know if you have any questions about the functionality. In the toolbar of these features, you’ll see a Send Feedback button which opens an email to our technical support team.

For the OpticStudio 17 release, the Feature Experiments list contains the Contrast Loss analysis.

The Contrast Loss analysis is a new map that shows how the contrast and MTF degrades across the pupil. It is intended to be used in conjunction with the new Contrast Optimization feature in section 3.1.
Contact Zemax support for more information about the Contrast Loss analysis.

9.5 RESEARCH SURVEYS (ALL EDITIONS)
Shape the future of Zemax

The Research Survey drop-down menu will be enabled when Zemax has a survey available for you to take.

10 DATA CATALOGS

10.1 NEW MATERIALS CATALOG (ALL EDITIONS)
Get the new Materials Catalog from Kopp Glass.

OpticStudio now includes a Materials Catalog from Kopp Glass. This catalog includes 23 new glasses.
10.2 UPDATED MATERIALS CATALOGS (ALL EDITIONS)

Get the latest Materials Catalog updates from Ohara, Osaka Gas Chemical, and Zeon.

The Ohara Materials Catalog has been updated to include the following materials:

- S-LAL20
- S-LAH52Q
- S-LAL54Q
- S-LAH97
The Osaka Gas Chemicals Materials Catalog has updated thermal coefficients for material OKP4HT.

The Zeon Materials Catalog has updated thermal coefficients for all ZEONEX materials. The previous ZEONEX materials ending in 2016 are now obsolete, and should be replaced with the new ZEONEX materials ending in 2017. In addition to updated thermal coefficients, ZEONEX_E48R_2017 also has updated dispersion coefficients.
10.3 **NEW TEST PLATE LIST (ALL EDITIONS)**

*Get the new Test Plate List from JML Optical.*

OpticStudio now includes a Test Plate List from **JML Optical**, called JML_cylindrical.tpd. This list includes 1077 new plates.

The Test Plate Lists are used by the Test Plate Fitting tool, which provides automatic fitting of radii to a vendor test plate list.
You can find the Test Plate Lists and the Test Plate Fitting tool in the Optimize tab.

### 10.4 Updated Test Plate Lists (All Editions)

Get the latest Test Plate Lists from II-VI Incorporated, Raytheon ELCAN Optical Technologies, POG GmbH, and Tucson Optical Research Corporation.

The **II-VI** Test Plate List has been updated and now includes 1104 plates.

The **Raytheon ELCAN** Test Plate List has been updated and now includes 13006 plates.

The **POG GmbH** Test Plate List has been updated and now includes 2175 plates.

The **Tucson Optical Research** Test Plate List has been updated and now includes 924 plates.

The following Test Plate Lists are obsolete and have been removed from the installer: Davidson Optronics.tpd, Janos.tpd, JDSU.tpd, MediVision.tpd, and Model.tpd.

### 11 Bug Fixes

OpticStudio 17 includes the following improvements and fixes.

**Sequential**

- **Ray aiming algorithm** - Improvements have been made to the ray aiming algorithm for wide angle systems.
- **GRADIUM surfaces** - An issue has been corrected with calculation of the effective focal length for GRADIUM lenses in systems with varying temperature or pressure.
- **MIRROR surfaces** - An issue has been corrected with the calculation of the center thickness of a surface with a MIRROR material and non-zero TCE in a system with varying temperature. This issue only occurred for systems in which the center thickness of the mirror was 0 at the nominal temperature.
- **Wavefront Map analysis** - The RMS wavefront error reported at the bottom of the Wavefront Map analysis is now calculated using the same algorithm as the error reported in the RMS vs. Field analysis.
- **FFT PSF, Huygens PSF, Wavefront Map, Foucault, and Interferogram analyses** - An issue with calculation of the pixel coordinates for the center of each pixel has been corrected for the following analyses: FFT PSF, Huygens PSF, Wavefront Map, Foucault, and Interferogram. This correction applies to data plotted in the Graph tab, and not the Classic tab.
- **Geometric MTF analysis** - For systems in which the chief ray is not traceable, an error will now be issued when attempting to scale the results from the Geometric MTF by the diffraction limit (previously incorrect results would be returned).
- **Footprint Diagram analysis** - A problem with the Footprint Diagram introduced in OpticStudio 16.5 Service Pack 5, that could lead to blank or erroneous results, has been corrected.
• **Cost Estimator tool** - An issue was fixed where the Cost Estimator did not read all Lens Data Editor parameters from ZMX file.

• **Cost Estimator tool** - An issue was fixed where the Cost Estimator allowed both Convex and Plano to be simultaneously selected.

• **POWF merit function operand** - An issue has been corrected with the X and Y effective focal length calculation from the POWF merit function operand for systems in which TAN (formerly VAN) field values were non-zero.

**Non-sequential**

• **Photoluminescent objects** - An issue in which the polarization of a ray scattered inside of a Photoluminescent material was not orthogonal to the propagation direction has been corrected.

• **Gradient index objects** - Improvements have been made to the algorithm for ray tracing through gradient index objects in non-sequential mode.

• **Detector Surface objects** - An issue with the total power displayed on the Detector Viewer for a Detector Surface object for systems in which the units were Lumens has corrected.

• **Radiometric conversion to RGB** - An IColorTranslator interface has been added to help convert radiometric values from analysis results such as the Detector Color data into RGB false color equivalents.